Aurora 2.5

Guest User Guide

Condrey Corporation
August 10, 2022



Introduction

Condrey Corporation makes no representations or warranties with respect to the contents or use
of this documentation, and specifically disclaims any express or implied warranties of
merchantability or fithess for any particular purpose. Further, Condrey Corporation reserves the
right to revise this publication and to make changes to its content, at any time, without obligation
to notify any person or entity of such revisions or changes.

Further, Condrey Corporation makes no representations or warranties with respect to any
software, and specifically disclaims any express or implied warranties of merchantability or fithess
for any particular purpose. Further, Condrey Corporation reserves the right to make changes to
any and all parts of the software at any time, without obligation to notify any person or entity of
such revisions or changes. See the Software EULA for full license and warranty information with
regard to the Software.

Any products or technical information provided under this Agreement may be subject to U.S.
export controls and the trade laws of other countries. You agree to comply with all export control
regulations and to obtain any required licenses or classification to export, re-export, or import
deliverables. You agree not to export or re-export to entities on the current U.S. export exclusion
lists or to any embargoed or terrorist countries as specified in the U.S. export laws. You agree to
not use deliverables for prohibited nuclear, missile, or chemical biological weaponry end uses.
Condrey Corporation assumes no responsibility for your failure to obtain any necessary export
approvals.

Copyright © 2022 Condrey Corporation. All Rights Reserved.

No part of this publication may be reproduced, photocopied, or transmitted in any fashion without
the express written consent of the publisher.

Condrey Corporation
122 North Laurens St.
Greenville, SC, 29601
U.S.A.



CONTENTS

L INTRODUCTION .ottt e e e et e e e et e e e e et e e e e et e e e eeta e e e e et s e e eataaeeeenenns 3
2 REGISTERING A NEW ACCOUNT .ottt e e e e e et e e e e et s e e e e e e e et e e aneeeens 5
3 RESETTING A FORGOTTEN PASSWORD .....ooiiiii et e e 8
4 SIGNING IN TO AURORA EXT ittt e e et e e e e et e et e et e e e e eeens 11
Y F=4 11 =1 © 1V ) PPN 12

5 MANAGING YOUR PROFILE ... .ottt e et st e et a et e e e aa e e 13
5.1 Editing YOUN Profile ProPerties .....uuiiiciieiiiiiiieeeiiiee ettt estte et e e e stee e s savae e e sabae e e ssnbee e e snabeeesennneeas 14
5.2 Changing YOUI PaSSWOIT .......ciiiiuiiiiiiiiieteciiee e et e e estee e e e e s saae e e e s sbe e e s snbaeeesnstaeeesnbeeeesnsseeesennsenas 15

6 BROWSING THE GUEST SHARES ... e e e 16
5.1 SEAICH GUESE SNAIES ..ccuieiiiiiiciee ettt te st e et e e st e e bt e e sabeeebeeesteesseeessteesnteesnsseesnseeenns 17

7 ACCESSING THE FILE MANAGEMENT INTERFACE ... 19
/2 R - 1o TU | T T U U P T U U P TP PP PP P PP 19
0] oY ule) oI NV 11 =1 o 11 L1 Y2 TSR 20
FAR 2T Y (ol O] o T=T - L (o] o ISP PPP PP PPPPN 21
7. 3.1 DOWNIOQU.......ocueeieiiieiieeieeeee ettt ettt ettt ettt e sbe e et e e site e e bt eesbeasabteenaseasabeaensseanas 21

W I A U o) (o T o [ET TS UURRNE 22
7.3.3 PrOVIBW ...ttt ettt ettt ettt ettt et e e ettt e e ettt e e ettt e ettt e et e e e nne e e e anneeenn 23

T B OPCN e, 24
7.3.5Create G NEW FOIUEL ..........ooeeeeeeeeeeeeeeee ettt s et s e st e e srta e s ssaeesateesasaesrtaesaseananes 24

Y N N -1 =1 (-SSP PRSPPI 24
7.3.7 RENGAME ...ttt ettt e ettt e e e e ettt e e e e e e e s s asbt e e e e e eeeasassbbaeeeaeeeaaaaanes 25
7.3.8 COPY (COPY-ANU-PASTE) ... ettee e ttee e ettt a e ettt a e et aesaasesesasseaesassesaeassenann 25
VRN Y [0V R (D] e o Be o Lo B D o) o) OSSP 26
7.3.10 MOVE (CUL-QNA-PASTE)........veeeeeeeeeeee e eettee et tee e ettt a e ettt a e et s e s s tseaesasseaesasssasasassenans 27
WO T B Y Vo [ [ (o Y4« BSOS PRSPPI 28
I W G e Lo o £ V4 | PR PRRE 29

A A TV O] o) o o 1R 30
7A4. 1 NQVIGALION PANE ..o 30

Y A D=1 (o ]|l o T TSP 32



Introduction

1.INTRODUCTION

For details on the File Management interface, refer to section 11 Accessing the File Management
Interface.

As a Guest user, you may have received a Guest Share email notification similar to the one below.

CCTEC Incorporated
5/15/2016 12:42 AM

A Shared Folder 'Catapult’ is ready for you
To: bemith@outsideorg.com

CCTEC Incorporated

A Shared Folder is ready for you.

You are receiving this email because Alice Jones at CCTEC Incorporated has setup an Aurora
Share for you at https./aurora-ext.cctec.org.

Share Name: Catapuit

Shared From: 2/14/2016 4:00:00 AM (Eastern Daylight Time)

Shared Until: 2/21/2016 4:00:00 AN (Eastern Daylight Time)
Description: E:%aaie review the Catapult project specifications by next

Access the Share

Access Instructions:

If you have already registered with CCTEC Guest Access, you may login and access the
provided share from your "My Shares" list.

If you are a first-time guest, you must register your email address before being able to login and
access the Aurora Share.

Powered by Aurora & 2016 Condrey Corporation.

To access the shared folder, click on the link provided in the email notification. This will direct you to
a sign-in page for the Aurora .Ext web application.



Introduction

: Aurora .Ext b3

& C () | @& https://aurora-ext.cctec.org/Account/Login?ReturnUrl=%2F ﬁ" L - B

Aurora .Ext Register  Sign in

Aurora 2.1
o9

Email Address

Password

Figure 1 - Aurora sign-in screen



Registering a New Account

2.REGISTERING A NEW ACCOUNT

Before you can access the shared content, you will need a registered account with the Aurora .Ext
system. To register a new account:

1. Click on the Register as a new user link at the bottom of the sign-in dialog
2. Enter the required fields, then click Register to continue.
The Email address field will also be used as the registered account name.

\David} — O
: Aurora Ext b
&« C 0 8 https://aurora-ext.cctec.org/Account/Register?ReturnUrl=%2f W % =
Aurora .Ext Register  Sign in

Register a new account

Email bsmith@outsideorg.com
Password | sesessens
Confirm password | sssessess
First Name Bob
Last Name Smith
Organization Outside Org Inc.

Type the code shown:
ql" |eq4sm

£ show another code

Reqgister Resend Confirmation Email

WI

Powered by Aurora v2.1.0.2 [Package 2.1.23] € 2018 Condrey Corparation

Figure 2 - Registering a new guest account



Registering a New Account

3. A confirmation will appear that registration is complete.

===
=Aur9ra (Ext X\C
€« C' | & https:;//aurora-ext.cctec.org/Account/Register? ReturnUrl =%2f P O =
Aurora .Ext Register  Sign in
Register a new account
Success: An email has been sent to bsmith@outsideorg.com.
Please view the email and confirm your account to complete the registration process.
Powered by Aurora v2.0.0 [Package 2.0.71] 8 2016 Condrey Corporation

Figure 3 - Registration continued

4. As part of the registration process, an email is sent to the registered email address to provide
confirmation.

CCTEC Incorporated
5/14/2016 11:58 PM

Confirm your account
To: bsmith@outsideorg.com

Please confirm your account by clicking here.




Registering a New Account

5. Click on the confirmation link to be redirected to confirmation page.

o=

sAurara.Ext X\__,
€« C' | @ https://aurora-ext.cctec.org/Account/Confirm?code=aTSIcA6lwzrQMor%2biM4XmNCdPaQGgpgcMndYx2zEpMQxX sy | B =
Aurora .Ext Register  Sign in

Account Confirmed

Thank you for confirming your account. Click here to login

Powered by Aurora v2.0.0 [Package 2.0.71] 8 20

Figure 4 - Registration complete

6. Click on the provided link to be redirected back to the sign-in page.



Resetting a Forgotten Password

3.RESETTING A FORGOTTEN PASSWORD

If you need to reset your password:

1. Click on the Forgot your password? link at the bottom of the sign-in dialog.
2. Enter your email address and the required CAPTCHA, then click Email Link.

G IEE |
: Aurora Ext x \‘ A
<« 5 https://aurora-ext.cctec.org/Account/Forgot A
Aurora .Ext Register  Sign in

Forgot your password?

Email bsmith@outsideorg.com

Type the code shown:
6 & g [657y9]

{3 Show another code

Email Link

Powered by Aurora v2.0.0 [Packsge 2.0.71] € 2018 Condrey Corporation

Figure 5 - Resetting forgotten password



Resetting a Forgotten Password

3. You should receive an email with a link to the password reset page. Click the link to access

the page.
=Rl
sAurara JExt X\__,
€« C' | & https://aurora-ext.cctec.org/Account/ResetPassword?code=LvKkx%2b5djTnyaXYeqCXwGBR7K93ITA0hKvHOUDGYp w e =
Aurora .Ext Register  Sign in

Enter your new password

Email bsmith@outsideorg.com

Password | sesessens

Confirm password | ssssssssd |

Powered by Aurora v2.0.0 [Package 2.0.71] @ 2018 Condrey Corparation

Figure 6 - Resetting forgotten password continued

4. Enter your email address and the new password in the Password and Confirm Password
fields, then click Reset.
5. The password reset confirmation will be displayed.



Resetting a Forgotten Password

6. Click the link to access the sign-in page.

o=

5 Aurora Ext x \_,
« C' | & https://aurora-ext.cctec.org/Account/ResetPasswordConfirmation PO =
Aurora .Ext Register  Sign in

Your password has been changed.
Click here to login

I3

Powered by Aurora v2.0.0 [Packsge 2.0.71] @ 2016 Condrey Corporation

Figure 7 - Resetting forgotten password complete

10



Signing In to Aurora .Ext

4.SIGNING IN TO AURORA .EXT

Enter the email address and password used during the registration process, then click Sign in to
continue.

: Aurora Share

& ()  https://aurora-ext.cctec.org/Account/Login?ReturnUrl=%2f

Register Sign in

Email Address

bsmith@outsideorg.com

Password

Sign in

el /

———
g

Powered by Aurora v2.5.0.22 [Package 2.5.57] © 2022 Condrey Corporation.

Figure 8 - Signing into Aurora .Ext

11



Signing In to Aurora .Ext

5. Signing Out
To sign out of Aurora .Ext, simply select Log out from the drop-down menu in the upper right-hand

corner of the web screen.

Hello, bsmith@outsideorg.com! «

# Manage Profile

ject specifications by next Friday G+ Log out

12



Managing Your Profile

.MANAGING YOUR PROFILE

To access the profile management page, select Manage Profile from the drop-down menu in the
upper right-hand corner of the web screen.

Hello, bsmith@outsideorg.com! =

# Manage Profile
ject specifications by next Friday G+ Log out

13



7. Editing Your Profile Properties

To modify profile attributes, make the appropriate changes in the Manage Profile page, then click

Update Profile to commit the changes.

Managing Your Profile

&

: Aurora Ext x

C () | @& https;//aurora-ext.cctec.org/Account/Manage

Aurora .Ext My Shares

Manage Profile

Account Name
First Name
Last Name

Organization

Change Password

bsmith@outsideorg.com

Bill

Smith

Outside Organization

[Change]

Profile successfully updated

Powered by Aurora ¥2.1.0.2 [Package 2.1.23] © 2018 Condrey Corporstion

Dawvid - =]

| & =

Hello, bsmith@outsideorg.com! ~

Figure 9 - Updating user profile

14



Managing Your Profile

8. Changing Your Password

To change your password, access the Manage Profile page, then click [Change] next to the Change
Password field.

David — =] %
: Aurora Ext x
& > C Y | & httpsy//aurora-ext.cctec.org/Account/ManagePassword T B O
Aurora .Ext My Shares Hello, bsmith@outsideorg com! ~

Change Password Form

Current password | sseeseses

New password | ssssssensans

Confirm new | ............ |

password
Change Password

Powered by Aurora ¥2.1.0.2 [Package 2.1.23] © 2018 Condrey Corporstion

Figure 10 - Updating user password

Enter your current password, then enter the new password in the New password and Confirm new
password fields.

Click Change Password to save the changes.

15



Browsing the Guest Shares

9.BROWSING THE GUEST SHARES

David — O ®
: Aurora .Ext b
(— c 0 ] https://aurora-ext.cctec.org b g 'ﬂ' ‘:
Aurora .Ext My Shares Hello, bsmith@outsideorg.com! -
Enter text to search...
Home View
Bﬂ Select all

Share: Project Catapult ST

Shared By: Adam James Upload B8 invert selection

Start: 11/21/2016 5:00 AM Transfer Open Select

- i ! -
End: 1/20/2017 5:00 AM [ > Project Catapuilt > ) y)
Description: Plezse review the docume..
v LU Project Catapult . .
i — =0 PDF |
rchived Document: -~
n A E %
Archived Blueprints Contract Proposal
Documents Template
4
4 items == E
Powered by Aurora v2.1.0.2 [Package 2.1.23] & 2018 Condrey Corporation

Figure 11 - Viewing contents of a guest share

The main display contains a list of Guest Shares and a File Management interface.
Each card in the Guest Share list displays the following information about each share:

e Share — the friendly name of the share given by the user who provided the share
e Shared By — the name of the user who provided the share

e Start — the start date when the share is first available

e End - the expiration date after which the share is no longer available

e Description — an optional description given by the share’s provider

To select a particular Guest Share, click on the card in the Guest Share list.

16



Browsing the Guest Shares

10. Search Guest Shares

In addition to simply browsing the list of Guest Shares, shares may be searched by matching text in
any of the Guest Share fields.

To search for matching shares:

1. Click in the Guest Share search text box at the top of the share list.
Enter the text to search by.
This can be any text that matches any of the displayed share fields, such as the Share name,
who it was shared by, the description, or even the display text of the start and end dates.

Share: Catapult

Shared By: Alice Jones

Start: 5/14/2016 4:00 AM
End: 5/21/2016 4:00 AM

Description: Please review the Catapult...

Share: Project Crossbow - Work i...
Shared By: Adam James

Start: 5/19/2016 4:00 AM

End: 5/26/2016 4:00 AM

Description: Here's a folder we can use...

17



Browsing the Guest Shares

3. Asyou type, the list of shares will be filtered to just those containing the matching text.

|catapu
Share: Catapult
Shared By: Alice Jones
Start: 5/14/2016 4:00 AM
End: 5/21/2016 4:00 AM

Description: Please review the Catapul...

4. Select your share from the filtered list by clicking on the share card.

18



Accessing the File Management Interface

11. ACCESSING THE FILE MANAGEMENT INTERFACE
12. Layout
The File Management interface is designed to have a similar look and feel as Windows Explorer.
A folder navigation pane is presented on the left, and a detail pane on the right.

As with modern versions of Windows Explorer, the File Management interface has a ribbon menu
with items organized in groups.

Home Wiew
J o cut x IEII ' f E g : HH select al
% ' E 1o Select none
Copy Delete Rename MNew Download Upload Open Add to ] :
folder zip... - DD Imvert selection
Clipboard Jrganize Jew Transfer Open Compression Select

19



Accessing the File Management Interface

13. Options Availability

Depending on the share permissions setup for a given share, one or more of the following operations
may not be available.

David| — [m] X
: Aurora Ext X
& C (| & https;//aurora-ext.cctec.org b=l - T
Aurora .Ext My Shares Hello, bsmith@outsideorg com! ~
|Enter text to search... |
Home View
Ha Select all

Share: Project Catzpult ST

Shared By: Adam James Upload EF N

Start: 11/21/2016 5:00 AM Transfer Open Select

. / | .
End: 1/20/2017 5:00 AM > Project Catapuit » 2 I
Description: Please review the docume.
¥ | Project Catapult . .
o : — A
rchived Document: A,
\ E %
Archived Blueprints Contract Proposal
Documents Template
“
4 items o |E|
Powered by Aurora v2.1.0.2 [Package 2.1.23] ® 2018 Condrey Corporation

Figure 12 - Guest Share with limited permissions

Operations that are not available are hidden from view, as shown in the example above. In this case,
only View and folder navigation permissions are available for the share named Catapult shown
above.

20



Accessing the File Management Interface

14. Basic Operations

; Download Download a file or folder
4 Upload Upload a file
= Preview View a document or media file
£, Open Open a folder or compressed file
: Add to zip Add files or folders to a compressed file
', Extract all Extract files and folders from a compressed file
"5 Copy Copy a file or folder
4, Cut Cut a file or file (for use as part of a move operation)
|j Paste Paste a copied file (copy operation) or cut file (move operation)
New folder Create a new folder
-ﬁ Rename Rename a file or folder
XK Delete Delete a file or folder

15. Download

To download a file or folder:

1. Select one or more files and folders from the navigation or detail pane.

2. Select " Download from the ribbon toolbar or context menu to download the selected
entries.

©® Downloading a folder retrieves a zip archive of all of that folder’s content. The download is
named based on the folder.

©® Downloading multiple selections at the same time retrieves a zip archive of all those contents.
The zip is named based on the first selected item.

21



Accessing the File Management Interface

16.Upload

To upload a file or folder, use the Upload Dialog (Option 1) or simply drag-and-drop selected entries
from Windows File Explorer into the browser (Option 2):

Option 1

1. Select 1' Upload from the ribbon toolbar or context menu.

Upload Files - stuff o X
f Select files to be uploaded
Drag and drop files and folders here.
Add files... Add folders... Remove Clear Upload

2. Add one or more files and folders to be uploaded by dragging files from the Desktop or
Windows Explorer into the file drop area, or by clicking Add in the upload dialog.
3. Click Upload to send the files to the selected folder.

Option 2
Alternatively, files and folders may be directly copied via drag-and-drop.

1. Navigate to the desired target folder in a Guest Share.
2. Using Windows Explorer, select one or more files and folders.
3. Drag the selected items onto a folder in the navigation pane or into the folder’s detail pane.

22



Accessing the File Management Interface

17.Preview

Many common document and media types may be viewed directly in the browser.

To preview a document or media file:

1. Select the file to preview. Ifitis a valid preview type, the /4 Preview ribbon item and context
menu will be enabled.

2. Select g Preview from the ribbon toolbar or context menu.

= Auvrora .Ext x
& C 0 | @ https:;//aurora-ext.cctec.org w | &84 =
Aurora .Ext My Shares Hello, bsmith@outsideorg_.com! ~
‘Enter text to search... PrOJeCt Catapu |t Please review the documents for next Friday's meeting.
Share: Project Catapult [ View -
Shared By:  Adam James 4 Project Overview.docx - Document Viewer <'Q%> - 0O X
Start: 11/21/2016 5:00 AM 2
172
End: 1/20/2017 5:00 AM D I Q @ i’ T d’
Traf|
Description: Please review the docume... Q @\ ) 49% "]
~ r
L]
| q [ & ]
v |

PROJECT CATAPULT

U yous rmacer i wh e g, abndrmt 8 o bypacady 4 sherl.
2 susmraary of s docurrment. Whe you' sy okl pour comtest,
[ ——

Titem  1item selected 19.0 KB

Powered by Aurors v2.1.0.2 [Package 2.1.23] € 2016 Condrey Corporation

For documents, depending on the document type, the previewed document may be printed or saved
as a PDF.

23



Accessing the File Management Interface

18.0pen

The Open operation opens or expands a folder or zip file. To open a folder or zip file:

1. Select afile or folder from the navigation or detail pane.

2. Select ﬂ- Open from the ribbon toolbar or context menu.

19.Create a New Folder

To create a new folder:

1. Select New Folder from the ribbon toolbar or the context menu.
2. Enter the name of the new folder in the New Folder dialog.

Create Folder =

Enter a name for the new folder:

[cw folge

QK Cancel

3. Click OK to save the name.
20.Delete
To delete a file or folder:

1. Select afile or folder from the navigation or detail pane.

2. From the ribbon toolbar or context menu select % Delete.
3. Click Yes in the confirmation dialog.

Delete File -

o Are you sure you want to delete this file?

Project Crossbow - Work in Progress.zip

Yes No

24



Accessing the File Management Interface

21.Rename

To rename a file or folder:

1. Select afile or folder from the navigation or detail pane.

2. From the ribbon toolbar or context menu select '—i' Rename.

Rename lkem hod

Enter a new name for the item:

Mew Project Files.zip

QK Cancel

3. Enter the new name, then click OK.
22.Copy (Copy-and-Paste)
To copy a file or folder:

Select one or more files and folders to copy.

Select " Copy from the ribbon toolbar or context menu.
Navigate to or select the target folder.

p wbdBE

Select E Paste from the ribbon toolbar or context menu to copy the contents to the target
location.

25



Accessing the File Management Interface
23.Move (Drag-and-Drop)

To move a file or folder via Drag and Drop:

1. Select afile or folder from the navigation or detail pane.

2. While keeping the item selected, drag the file or folder to another folder in the detail pane or
the navigation pane.

David; — ]
= Aurora .Ext X
(— G 0 ] https://aurora-ext.cctec.org < .¢, -
Aurora .Ext My Shares

Hello, bsmith@outsideorg.com! =

PFOJ eCt Catap LI |t Please review the documents for next Friday's meeting

Enter text to search...

Share: Project Catapult ECEE Ve
- / i R
Shared By: Adam James = do Cut x _:Il ; f H g A BH setect al
s i . = —J = 4 * ! Select none
Start: 11/21/2016 5:00 AM Copy Delete Rename New Download Upload Open  Preview Add to
foider Zig. - I:FI Invert selection
End: 1/20/2017 5:00 AM ) _ o ) - i
Description: Please review the docume... ——— —— — - -
. > Project Catapult » ] R
v | Project Catapult X
Archived Documents [— m
' o
Archived Blueprints Contract Proposal
Documents Template

|—) Move to Archived Documents

Figure 13 - Moving files via drag-and-drop
3. Release the selection when the target folder is activated.

In some cases, you may see this error:

Action Errar

>

e (17) The system cannot move the file to a different disk drive:

QK

A cut-and-paste or move operation is treated as a single file system operation, so in cases where the
source and target paths are on separate drives or volumes, a different approach must be taken.
1.

Select a file or folder to move from the navigation or detail pane.
2.

N
Select = Copy from the ribbon toolbar or context menu.

Navigate into the target folder or right-click on the folder from the detail or navigation pane,
then select O Paste.

26




Accessing the File Management Interface

4. Navigate back to the original folder.
5. Reselect the source object, then select X Delete from the ribbon toolbar or context menu.

24.Move (Cut-and-Paste)
To move a file or folder via Cut-and-Paste:

1. Select a file or folder from the navigation or detail pane.

2. Select > Cut from the ribbon toolbar or context menu.
3. Navigate into the target folder or right-click on the folder from the detail or navigation pane,

then select D Paste.

In some cases, you may see this error:
Action Error pod

e (17) The system cannot move the file to a different disk drive:

oK

A cut/paste or move operation is treated as a single file system operation, so in cases where the
source and target paths are on separate drives or volumes, a different approach must be taken.

6. Select a file or folder to move from the navigation or detail pane.
7. Select " Copy from the ribbon toolbar or context menu.
8. Navigate into the target folder or right-click on the folder from the detail or navigation pane,

then select 5| Paste.
9. Navigate back to the original folder.
10. Reselect the source object, then select X Delete from the ribbon toolbar or context menu.

27



Accessing the File Management Interface

25.Add to Zip

To add one or more files and folders to a new zip archive:

1. Select the files and folders to be added.

2. Select ¢ Addto zip from the ribbon toolbar or context menu.

Add ltems to Zip >

Enter a name for the zip file:

Project e

QK Cancel

3. Specify the name of the zip file, then click OK.

Note that this process only creates a new zip file. To add files or folders to an existing zip file:

1. Select the files and folders to be added.
2. Select " Copy or > Cut from the ribbon toolbar or context menu.

3. Navigate into the target zip file, then select B Paste.

28



Accessing the File Management Interface

26.Extract from Zip

To extract a zip file:

1. Select the zip file to extract.

2. Select g2 Extract all from the ribbon toolbar or context menu.
3. Inthe sub-select menu, choose Extract all to or Extract all here

 PDF |

[N L LS

> €

Cpen

Project Files Project Files.: Download

Review.pdf Upload

Add to zip...

Extract all ¥ | Extract all to...
{7

Cut Extract all here

Copy

Delete

Fename

B ML X P o< el b

Imvert selection

4. If Extract all to was selected, specify the name of a sub-folder to create and extract the
contents into.

Extract ltems From Archive oo

Enter a folder name to extract the archive file to:

LNC o

OK Cancel

29



27. View Options

28.Navigation Pane

Accessing the File Management Interface

The navigation pane may be collapsed or expanded by using the splitter bar toggle option.

e ] X
: Aurora .Ext X
& C () | & https://aurora-ext.cctec.org | & O
Aurora .Ext My Shares Hello, bsmith@outsideorg.com! ~
‘E”te' text to search... ‘ PI'OJeCt Catapu It Please review the documents for next Friday's meeting
Home View
Share: Project Catapult
Shared By: Adam James i seectan
Select non
Start: 11/21/2016 5:00 AM st
EID Invert selection
End: 1/20/2017 5:00 AM -
Description: Please review the docume... - —
L0 > Project Catapult > o t pr
Vv . Project Catapult
Archived Documents v prem— m
Archived Blueprints Contract Proposal
Documents Template
“
4 items B== EI
Powered by Aurora v2.1.0.2 [Package 2.1.23] © 201 rey Corp n

Figure 14 - Navigation panel splitter bar collapse option
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Accessing the File Management Interface

: Aurora .Ext

x

&« C Y | & https;//aurora-ext.cctec.org

Aurora

Ext

My Shares

David - =]

Hello, bsmith@outsideorg.com! ~

ch... |

|Enter text to sean
Home View
Ba Select all
Share: Project Catapult FeTE T
Shared By:  Adam James Upload DD Invert selection
Start: 11/21/2016 5:00 AM Transfer Dpen 2
End: /20/2017 5:00 AM

» Project Catapult »

=

Description: Please review the docume...

aued uonebiaep)
[ < |
o

E

Archived Blueprints Contract Proposal
Documents Template
4 items
Powered by Aurora v2.1.0.2 [Package 2.1.23] ® 2018 Condrey Comporation

Figure 15 - Collapsed navigation pane

In addition, the navigation pane may be hidden altogether:

1. Select the View tab on the ribbon toolbar.

2. Click the (¥ Navigation pane button to toggle the visibility of the navigation pane.
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Accessing the File Management Interface

29.Detail Pane
The items in the detail pane may be displayed as icons or as a detail list.
To change the detail display:

1. Select the View tab on the ribbon toolbar.
2. Click the display option in the Layout ribbon group.
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Alternately, a simple toggle between the current icon size and the detail view is available in the
bottom right corner of the detail pane:
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Figure 16 - Toggle detail pane view

32



	1. Introduction
	2. Registering a New Account
	3. Resetting a Forgotten Password
	4. Signing In to Aurora .Ext
	5. Signing Out

	6. Managing Your Profile
	7. Editing Your Profile Properties
	8. Changing Your Password

	9. Browsing the Guest Shares
	10. Search Guest Shares

	11. Accessing the File Management Interface
	12. Layout
	13. Options Availability
	14. Basic Operations
	15. Download
	16. Upload
	17. Preview
	18. Open
	19. Create a New Folder
	20. Delete
	21. Rename
	22. Copy (Copy-and-Paste)
	23. Move (Drag-and-Drop)
	24. Move (Cut-and-Paste)
	25. Add to Zip
	26. Extract from Zip

	27. View Options
	28. Navigation Pane
	29. Detail Pane



